
 

 
 
 

Studio B Training Class 
Two week workshop for Studio B Certification 

 
 
 

PUBLIC ACCESS 
MISSION 

STATEMENT 
“To provide a venue, 

resources and 
opportunities for residents 

to utilize the medium of 
television to 

independently produce 
their own non-

commercial, non-profit 
message in the most cost-

effective manner.” 
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Facility Operations 
 
SWOCC STUDIO PROCEDURES 
 
1. Office hours are 8:30 a.m. – 4:30pm. Monday thru Friday.  Evenings and weekends 

are by appointment. 
 
2. All questions, troubleshooting, scheduling, and checkout of equipment must go 

through Community Relations, or staff person assigned to production. 
 
3. First-time shows require character generation to be prepared at least one day in 

advance by a crew person. On going productions (those with CG already formatted) 
may take changes at the time of the show.  

 
4. Access on those areas necessary for production. Staff offices (including front office) 

are off limits.  
 
5. Staff will supervise all shoots and complete all technical adjustments. Staff will NOT 

crew any positions for any show at any time. Staff reserves the right to stop, or cancel 
any production for any reason at anytime. 

 
6. Residents may not touch (use) equipment without staff approval.  
 
7. Microphones will be checked out to the producer at the time of studio check in. They 

should be returned to staff at time of studio check out.  
 
8. Do not step on or roll over any cables.  
 
9. The facility is to be left exactly as it was found.  
 
10. Crew is responsible for returning/putting away the equipment they used/manned.  
 
11. The producer is responsible for tape stock, actions & behaviors of guests, talent & 

crew. Also producer is responsible for cleaning up after their production. 
 
12. In the event any procedures are violated, staff will complete necessary documentation 

to alert the Executive Director who will determine action, up to and including 
suspension of facility privileges.  

 
13. Policies for use of studio, equipment and access channels are set forth in the SWOCC 

Public Access Television Policies.  
 
14.  All procedures are noted in the Producers workshop. 
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Facility Operations 
 
Procedures For Production 
 
3. Producer must contact the SWOCC to set up a pre-production meeting with a 

SWOCC staff member, at least two weeks prior to the studio production. 
 
4. During the Pre-Production meeting, perimeters of the production will be set. 

Anything not discussed previously in the pre-production meeting will not be allowed 
or implemented during the actual production. 

 
5. A pre-production meeting must take place prior to each production/show until staff 

deems unnecessary. Staff reserves the right to require pre-production meetings as 
necessary.  

 
6. Producers must arrive within 15 (fifteen) minutes of the scheduled appointment time. 

A user arriving more than fifteen minutes late will have their reservation forfeited. 
 
7. Producers are responsible for set-up and strike of the set. Appointment times should 

be made to reflect the necessary needed time for each production.  
 
8. Producers are expected to contact SWOCC staff if he/she is unable to make an 

appointment, or if they will be delayed. Leaving a voice message does not constitute a 
reservation cancellation or tardiness. Confirmation must be received from a staff 
member. 

 
9. Producers may only use certified crew for a production. The producer is required to 

provide a complete list of crew and assignments to their assigned staff member prior 
to a production. 

 
10. Producers are responsible for understanding and following all polices in the Public 

Access Polices book. Producers are responsible for their crew, talent and other 
persons on set, and that they must abide by the same polices. 
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WEEK 1            
 
Physical Attributes of the Camera 
 
Lens-What the Camera Sees 
 Zoom-Change what the camera sees from wide angle to narrow angle. 
 Focus- Used to make the picture appear sharp and clear  
 Iris- Controls the amount of light that enters the lens.  
  
CCD (Charge-Coupled Device)- a small solid-state silicon chip that 
contains horizontal and vertical rows of thousands of light sensing picture 
elements called pixels.  
 
 
 
 
 
 

Lens 

Pan/Tilt 
Mechanism 

Camera 
Body 
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WEEK 1            
 
Under the Camera 
 
Tripod (sticks) 

Pedestal Control/Lock 
Leg Height Control/Lock 
Camera Head-Mount 

Dolly 
Wheels 
Tripod Feet Lock 

 
 
Movement Definitions 
 
Tilt up/down- Up and down movement of the camera on the tripod. 
Pan right/left- Side to side movement of the camera on the tripod. 
Pedestal up/down- Physically raising or lowering the camera with the tripod. 
Zoom in/out- Either using the Zoom Controls or Manually adjusting the zoom in or 
out until the subject is in frame. 
Dolly in/out- Movement of the camera and tripod across the floor toward the subject 
(dolly in) or away from the subject (dolly out). 
Truck left/right- Side to side movement of the camera and tripod across the floor. 
Arching- Camera trucks and dolly’s at the same time, moving in a semi circle around 
the subject. 
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WEEK 1           
 
Camera Movement Examples 
 

 

Dolly in 
Dolly out 

Truck Left 

Truck Right 

Arc Left 

Arc Right 

Pan Left Pan Right 

Tilt Up 

Tilt Down 
Pedestal Up 

Pedestal Down 
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WEEK 1           
 
Through the View Finder 
 
Aspect Ratio- The ratio of the width of the television screen to its height. 
The standard ration is 4 x 3 ( four units wide by three units high); HDTV 
(high-definition television) is 16 x 9 ( sixteen units wide by nine units high).  
 
White Balancing- To see a white object as white, the camera must be told 
whether the light in which it is operating in is white. This is a camera 
adjustment to compensate for a bluish or reddish light. White balancing the 
camera should be done anytime the light changes on an object. This is an 
automatic feature on most consumer camcorders. 
 
Safe Title- Refers to the picture area that will be seen by most television 
receivers in the home. 
 
Camera Bars- Serves as a reference for the color monitors or for the 
playback of the recording. 
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Framing Definitions 
 
 
XCU (Extreme Close-Up) – A view of just the subjects face. 
 
CU (Close-Up)- A head and shoulders shot of subject. 
 
MS (Medium Shot)- A view of the subject from the waist up. 
 
LS (Long Shot)- A view of the subject from head to toe. 
 
WS (Wide Shot) or XLS (Extreme Long Shot) or Cover Shot- A view of 
the subject and their surroundings. 
 
One Shot - One person in the frame. 
 
Two Shot- Two people in the frame. 
 
Three Shot- Three people in the frame. 
 
Over the Shoulder- A camera view looking over the shoulder of one 
subject at another subject face front. 
 
Headroom- Space above the head of the subject 
 
Talk (Lead) Room- Space in front of a profiled subject, or ahead of 
someone moving on camera. 
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WEEK 1           
 
Picture Composition Examples 
 
 
 
. 

Extreme Long Shot (XLS) 
or Cover Shot 

Long Shot (LS) or 
Full Shot 

Medium Shot (MS) or 
Waist Shot 

Close-up (CU) Extreme Close-up (XCU) 

Two Shot Over the Shoulder Shot 
(O/S) 
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WEEK 1           
 
Picture Composition Examples 
 
 

Too Much Headroom Too Little Headroom 

Too Little Noseroom Too Much Noseroom Perfect Noseroom 
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WEEK 1           
 
Picture Composition Examples 
 
 

Pointing to Nose Room 

Problematic Composition: 
Plant 

Problematic Composition: 
Flag 

Too Little Leadroom Perfect Leadroom 
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WEEK 1      
 
Crew Definitions 
 
Producer In Charge of one or several program series. Manages budget and 

coordinates with talent, clients, studio management, writers, etc. 
Incurs sole responsibility for all aspects of a production, including 
all personnel working on a production, coordinating technical, and 
non-technical production elements. Often serves as director and 
writer.  

 
Asst. Producer Assists producer in all production matters. Often do those actual 

coordinating jobs, such as telephoning to schedule and confirm 
crew, talent, studio reservations, etc. 

 
Director In charge of directing talent and technical operations. Is ultimately 

responsible for transforming a script into an effective video and 
audio message. 

 
Technical Director Does the switching and acts as technical crew chief. Often serves 

as director. 
 
Production Asst. Assists producer and director during actual production.  
 
Camera Operator Operates camera, takes direction from Director, one operator often 

serves as floor manager.  
Audio Technician In charge of all audio operations. Works audio console (mixer) 

during the show. Takes cues from director. 
 
C.G. Operator Types and/or recalls from the computer the names and other 

graphic material to be integrated with the video image. Takes cues 
from the director. 

 
Floor Manager In charge of all activities on the studio floor. Directs talent, relays 

director’s cues to talent, and supervises floor personnel. 
 
 
Talent Refers to all performers and actors who regularly appear on 

television. 
 
Editor Non-linear or linear edits the production according to the 

producer’s notes, or direction. Often is done by the producer or 
director. 
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WEEK 1           
 

The Control Room 
 
The Switcher- A panel with rows of buttons that allows the selection and assembly of 
various video sources through a variety of transition devices, and the creation of 
electronic special effects.  
 
VTR (Video Tape Recorder)- Records the Video and Audio signal onto videotape.  
 
The Character Generator- A computer dedicated to the creation of letters and numbers 
in various fonts. Its output can be directly integrated into video images.  
 
CCU ( Camera Control Unit)- Equipment, separate from the actual camera, that allows 
the video operator to adjust the color and brightness balance before and during the 
production.  
 
The Audio Console (Board or Mixer)- Controls the volume of all inputs, mix some or 
all of the inputs signals in various ways, and manipulate the sound signals of each 
channel for the final mix.  
 
CD Player- Compact disk player used to add music to studio productions. 
 
Clear Com- Intercom system used to facilitate voice communication between control 
room and studio.  
 
Program Monitor- Program output of the video switcher. 
 
Preview Monitor- Preview output of the video switcher. 
 
Waveform/Vector scope Monitor- Measures the brightness and color of the program 
video signal. 
 
On-Air Light- Light that is turned on to alert others a production is in progress.  
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WEEK 1           
 

The Control Room 
 

 
 
 

Waveform/ 
Vector Scope 

Monitor 

Preview 
Monitor 

Program 
Monitor 

The Switcher CG 

Audio Board 

CD Player 

VTR 8 

VTR 9 
Timer 

Remote CCU 
Intercom 

Source 
Monitors 

Editor 
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WEEK 1           
 

The Switcher 
 

 

Preset Bus (Preview) 

Cut/Take Button T-Bar 

Program Bus Program 

Preset 

 

Effects 
T-Bar 

 
DSK 

Cut/Take 

A Bus (Effects) 

B Bus (Effects) 

Fader 

 

Mix Button Wipe Button 

Key Level 

Edge 

Wipe Edge 
Softness/ 
Boarder 

Effects 
Button 
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WEEK 1      
 
The Switcher 
 
Preset (Preview) Bus- Lit button is being sent to the Preview Monitor. 
Program Bus- Lit button is being sent to the Program Monitor. 
 
Cut- The instantaneous change from one shot (image) to another. 
 
Effects Mode- Dissolves or Wipes are used to transition from one video signal to 
another. 
 
Mix Mode- Dissolves are used to transition from one video signal to another. 
 
Wipe Mode- Wipes are used to transition from one video signal to another. 
 
Manual- Use T-Bar for manual transitions. 
 
DSK (Down Stream Keyer)- A control that allows the title to be keyed (cut-in) over the 
picture (Program out signal) as it leaves the switcher.   
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WEEK 1      
 
Directing using the Switcher 
 

 
 

 
Directing in Program Mode 
1-Select PGM 
2-Select the video source on the Preset Bus you want to switch to. 
 
 
Directing in Preset Mode 
3-Select PST 
 
To Cut in Preset Mode 
4- Select the video source on the Preset Bus you want to switch to. 
5-Press the Take Button 
 
To Dissolve in Preset Mode 
6- Select the video source on the Preset Bus you want to switch to. 
7-Push or Pull the T-Bar toward or away form you. 
 
 

1,3 2,4,6 5 7 
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WEEK 1      
 
Directing using the Switcher 
 

 
 

 
Directing in Preset Mode 
1-Select PST 
 
To Dissolve using the Effects Bus 
2- Select EFF 
3-Push the Effects T-Bar toward A Effects Bus 
4-Select the same video source on the A Effects Bus as on the Program Bus 
5- Select the video source on the B Effects Bus you want to switch to 
6-Select Mix 
7-Press Take button 
8-Pull the Effects T-Bar Toward you 
 
To Wipe using the Effects Bus 
9-Follow steps 1-5 
10-Select Wipe 
11- Press Take button 
12- Pull the Effects T-Bar Toward you 
 

1 2 

4 3,8,12

5 

6 

7,11 

10 
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WEEK 1      
 
Selecting Effects 
 

 
 

 
 
To Select an Effect 
1-Press the Wipe Button 
2-Press Button that corresponds with the desired wipe 
 
Or, if you have found an Wipe you wish to use off the Effects Palette: 
3-Press the Wipe button Twice (Three Red 000’s will light) 
4-Punch in number of wipe by pressing one of three top wipe buttons.  
   (First button corresponds to first 0, Second Button with second 0, etc.) 
5-Press the “enter” key 
 

1,3 

2 

4 

5 
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WEEK 1      
 
Camera Controller 
 

 
 
 

Pan/Tilt/Zoom 
Joystick 

Speed 
Knob 

Iris 
Knob 

Focus 
Knob 

Touch Screen 

Camera 
Selects 



 23

SWOCC Studios 
Studio B Training Class 

 
 
WEEK 1      
 
Camera Controller 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
To preset Camera Positions 
1-Ajust Camera to desired position 
The following steps will be done on the Touch Screen 
2-Press preset number on which to store camera position 
3-Press Store 
 
To recall a preset position 
4-Press preset number you wish to recall 
5-Press Recall 

1 

2, 4 

3 
5 
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WEEK 1      
 
The Time Clock 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
To Set the Timer: 
    (Example Time: 00:10:30) 
1-Hold the Timer Button 
2-Press the Select/Reset two times until the second set of 0’s blinks 
3-Press Set/Stop 10 times to advance the timer 10 minutes 
4-Press Select/Reset one time until the third set of 0’s blinks 
5-Press Set/Stop 30 times to advance the timer 30 seconds 
6-Press Select/Reset once until no numbers blink 
 
To Reset the Timer: 
7-Press Select/Reset 
 
To Start the Timer: 
8-Press the rocker switch Up to start counting up or Down to start counting down 

1 2,4,6,7 

3,5 8 
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WEEK 2      
 
Microphones 
 
Pick up Pattern- The zone within which a microphone can hear well. (Omni- and Uni- 
directional) 
 
Omnidirectional- hears equally well from all directions.  
 
Unidirectional- hears especially well in one direction. 
 
 Cardioid- Unidirectional mic which has a heart-shaped pickup pattern. 
  

Hypercardioid- Unidirectional mics which has a “long reach,” meaning it can 
pick up sounds that are farther away. Because these mics are fairly long and are 
aimed at the sound source, they are commonly called Shotgun mics.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Omnidirectonal Uni-directonal 
Cardioid 

Uni-directonal 
HyperCardioid 
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Microphones 
 
Lavaliere (Lav) Microphone- a very small, rugged, omnidirectional microphone that is 
used primarily for voice pickup. Usually clipped to clothing.  

 
 
Hand Held Microphones- a microphone that is handled by the talent, used in situations 
in which you need to exercise some control over the sound pickup.  

 
 
Shotgun (Boom) Microphone- a long, unidirectional microphone that is used to pick up 
sound sources farther from the microphone; used whenever the mic is to be kept out of 
the picture. 

 
 

Pressure Zone Microphone (PZM)- a small omnidirectional boundary microphone that 
can be placed on a table, wall, floor, lectern, or any flat surface. A small microphone is 
mounted face-down a short distance from the reflective boundary plate. This creates a 
pressure zone between the plate and the mic. The microphone detects changes in this 
pressure zone, rather than the conventional method of detecting changes in the 
surrounding air pressure (i.e. sound waves). 
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Connector 
 
 

Female 
XLR 

Male 
XLR 

Male 
RCA 

Female 
RCA 

Male 
Phone 

(Quarter Inch)  

Male 
Mini  
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Studio Panel 
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WEEK 2      
 
Audio Board 
 
 Power Switch 

Faders 1-4: 
Microphone Inputs 

Faders 5-10: 
Patchable Inputs 

Trim 

Auxiliary Inputs 

EQ-High 

EQ- Mids 

Pan Left or Right 

Mute Button 

 

Fader 

 Solo Button 

Control Room 
Volume Control

Phantom Power 

EQ- Low 
Control Room
Feedback
0

Solo 
Indicator Light 

VU Meter 

 

Main Mix 
Master Fader 



 31

SWOCC Studios 
Studio B Training Class 

 
 
WEEK 2      
 
Setting up the Audio Board 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1-Slide Main Mix Fader to 0db or Unity 
2-Slide faders 9 and 10 (PSW 5) until VU Levels are at 0db  
3-Adjust Control room volume to desired level 
4-Adjust Levels on VTR 8 to -20db 

 
You have now calibrated the output from the mixer with the input of the deck.  
 
 
 

4 

1 

2 

3 
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WEEK 2      
 
The Character Generator 
 
1. Open Deko500 Program 
 

 
 
 

 
2. Click: Window>Select Layout>Style Edit or ALT + F11 on the keyboard 
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WEEK 2      
 
The Character Generator 
 
3. To open a Graphic: File>Open 
 

 
 
 

 
4. Creating a New Graphic : Layer>Delete Layer 
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WEEK 2      
 
The Character Generator 
 
5. Click on Preset Style Window 
 

 
 
 

 
6. Click : Presets>Reset to Defaults 
 

 

5 
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WEEK 2      
 
The Character Generator 
 
7. Select I-Beam tool 
8. Draw text box from safe title area to safe title area 
 

 
 

 
9. Click on a font and type desired text 
 

7 

8 

9 
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WEEK 2      
 
The Character Generator 
 
10. Click one letter to the end of the row or page you wish to select, Right Arrow over, 
then Shift + Left Arrow till all text is selected. 
 

 
 

 
11. Manipulate Font Look and Style. 
 

 
 

10 
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WEEK 2      
 
The Character Generator 
 
12. To Create Text Roll: Text>Vertical Scrolling 
 

 
 
 

 
13. Select I-Beam and Drag Text Box from safe title to safe title, Click on a font and type 
desired text. 
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WEEK 2      
 
The Character Generator 
 
14. To Create a Sequence: Window>Select Layout>Sequence Playback or F11 on 
keyboard  
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WEEK 2      
 
The Character Generator 
 
 
Creating a Sequence 
15. Select Event 1 
16. Change Options to Control: Stop, Time: 0, Effect: Dissolve, Layers: Blank, File 
Name: Blank, Rate: 15, Units: Frames. 
17. Select Browse 
18. To import a file: Double Click (always start with a blank page) 
19. Remember to change credit roll Effect to Roll and Unit to Seconds.  
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

15 

16 

18 

19 

17 
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WEEK 2      
 
The Character Generator 
 
Short Cuts to Remember 
 
Alt + Arrow: Move Object 
CTRL + Space Bar: Fine Movement vs. Course 
Alt + F11: Style Edit 
F11: Sequence Playback 
F5: New Graphic 
 

 
 
 
 
 

 
 
 

Add 
Text 

I-Beam 

Move 
Tool 

Rotate/Skew 
Tool 

Add 
Rectangle 

Add 
Ellipse 

Pointer 


